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Albums

Access the Open Album Dialog Box 

You open an album file from the Open Album Dialog Box. You can access the dialog box by selecting "Open" from the
AlbumFile Menu, or you can:

Click on the Open Album Toolbar Button.

Press Ctrl+O. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box.

Select the Directory

You change the directory from the Directories List Box.

Select the Album File

You select the album file from the File Name Combo Box.

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will open the selected album.



Albums

You can save the changes to the current album by selecting "Save" from the AlbumFile Menu, or you can:

Click on the Save Album File Button.

Press Ctrl+S. 

If you are working with a new album and have not saved it yet, Image Album 2.0 will present the Save As
Dialog Box.



Albums

You close the current album by selecting "Close" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Close".

Press Alt+F, then press C.

If you have made changes to the album, you will be prompted to save the changes:

To save the changes, click on the Yes Button, or press Alt+Y.

To close the album without saving the changes, click on the No Button, or press Alt+N.

To return to Image Album 2.0 without closing the album, click on the Cancel Button, or press Esc.



Albums

Access the Save As Dialog Box 

To access the dialog box, select "Save As" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Save As".

Press Alt+F, then press A.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box.

Select the Directory

You change the directory from the Directories List Box.

Enter the New Filename

Image Album 2.0 automatically enters the current filename into the File Name Text Box. You enter a new name by 
typing over this text. Don't worry about the file extension - the ".ALB" at the end of the filename - Image Album 2.0 will
add it automatically.

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will make a copy of the album and assign it the new filename. 



Albums

You can merge two albums into a single album. The receiving album receives thumbnails from the 
source album. When the merger is complete, the receiving album contains the combined contents of both
albums, and the source album is unchanged. 

Open the Receiving Album

Use the File Open Command to open the receiving album. 

Select the Source Album

You select the source album from the Select Album Dialog Box, which works just like the Open Album Dialog Box. To 
access the dialog box, select "Merge" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Merge".

Press Alt+F, then press M.

Delete the Source Album (Optional)

Since all of the source album's media files are now contained in the receiving album, you may want to delete the 
source album. 



Albums

Open the Album

Use the File Open Command to open the album that you want to delete. 

Select the Delete Album File Command

You select the Delete Album File Command by choosing "Delete" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Delete".

Press Alt+F, then press D.

Respond to the Delete Album Prompt

When you select the Delete Album File Command, Image Album 2.0 will present the Delete Album Prompt.

To delete the album, click on the Yes Button, or press Enter.

To leave the album intact, click on the No Button, or press Alt+N.



Albums

Access the Print Album Dialog Box 

Click on the Print Album Button.

Select "Album" from the AlbumFile Print Sub-Menu.
Press Alt+F, then P, and then A.

Set the Print Range

You can print the entire album, the selected thumbnails, or a range of pages. Use the Print Range Group Box to 
select an option.

Set the Print Quality

You set the print quality from the Print Quality Drop Down Box.

Enter the Number of Copies (Optional)

If your printer supports multiple copies, you can enter the number of copies that you want to print into the Copies Text
Box. 

Select Thumbnails or Files

You can print the thumbnails or the underlying files. Use the Print Using Group Box to make a selection.

Change the Printer (Optional)

The current printer is listed at the top of the Print Album Dialog Box. If you want to select a different printer or change 
your printer setup, click on the Setup Button, or press Alt+S. 

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will send the album to the printer. 



Copies Text Box
---------------------------------------------------------------------
-------

---------------------------------------------------------------------
-------
Enter the number of copies that you want to print 
into the Copies Text Box. If your printer does not 
support multiple copies, the text box will be grayed 
out. To access the text box, click in it, or press 
Alt+C. 



Print Using Group Box
-----------------------------------------------------
---------

-----------------------------------------------------
---------

Click on the option's text or button.

Press Alt plus the option's underlined 
letter.



Print Quality Drop Down Box
The entries in the Print Quality Drop Down 
Box are determined by the type of printer you 
are using.
-------------------------------------------------------------
-------------

-------------------------------------------------------------
-------------

Click on the drop down box to open it, then 
click on a selection.

To access the drop down box, press Alt+Q. 
Use the cursor keys to highlight the selection 
you want.



Print Range Group Box
-------------------------------------------------------------------------------------------
----------

Click on the option's 
text or button.

Press Alt plus the 
option's underlined 
letter.

-------------------------------------------------------------------------------------------
----------
If you select the Pages Option, enter the range of pages in the From 
and To Text Boxes. To access a text box, click in it, or press Alt plus 
the text box label's underlined letter. For example, to access the 
From Text Box, press Alt+F.



Albums

You edit an album's title from the Album Title Dialog Box. To access the dialog box, select "Title" from the 
AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Title".

Press Alt+F, then I.

Type the new title into the text box, then press Enter. If you decide that you don't want to change the title, 
click on the Cancel Button, or press Esc.

Please Note:
An album's title is not its filename. To change an album's filename, make a copy of the file with a different
 filename, then delete the copy with the old filename.



Albums

You view an album's information from the Album Info Dialog Box. To open the dialog box:

Click on "View" in the menu bar, then click on "Album Info".

Press Shift+A.

When you're done reading the album's information, click on the OK Button, or press Enter.



Creating an Album

An album is a collection of thumbnails that represent media files. Creating an album is a three-part 
process:

Starting the new album file

Adding media files

Saving the new album



Creating an Album

Select the New Album File Command

You can select the New Album File Command by choosing "New" from the AlbumFile Menu, or you can:

Click on the New Album Toolbar Button.

Press Ctrl+N. 

Image Album 2.0 will open the Album Title Dialog Box. 

Enter the Album's Title (Optional)

When an album has a title, it appears in the left panel on the Status Bar. You may find that a title makes it easier to 
remember an album's purpose. Entering a title is optional. 

Please Note: An album's title is not its filename.

To enter a title, type it into the text box, then press enter. To access the text box, 
click in it, or press Alt+E. A title's length is limited to fifty characters, or as much text as will fit in 
the text box, whichever comes first.

To continue without entering a title, press Enter, or click on the OK Button.



Creating an Album

When you close the Album Title Dialog Box, Image Album 2.0 will open the Add Files By Dialog Box. You
use the dialog box to select one of two methods for adding files to the new album: 

 Selecting Files                 
 Scanning Directories

When you add files by selecting them, you pick individual files from a single directory. 

Select the Selecting Files Option

Click on "Selecting Files", then click on the OK Button. 

Press Alt+F, then press Enter. 

Image Album 2.0 will open the Add Files Dialog Box. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the File Type

You select the file type from the File Type Drop Down Box. You cannot add animation files to an album if your system 
does not support animation. If you receive error messages, then either your system doesn't support animation, or 
your system is improperly configured. 

Select the Files

You select the files from the File Name Combo Box. You can select a single file, a sequential group of files, or a non-
sequential group of files. 

Select the OK Button

Click on it, or press Enter. Image Album 2.0 will add the selected files to the album.



Selecting Non-Sequential Files
--------------------------------------------------------------------------------------------
----------

Press and hold Ctrl while 
you click on the files that you
want to select. 

Type the filenames, 
separated by spaces, into 
the text box.



Selecting Sequential Files
---------------------------------------------------------------------------------------------
----------

Click on the first file in the 
sequence, then press and 
hold Shift while you click on 
the last file. 

Use the cursor keys to select 
the first file in the sequence, 
press and hold Shift, then 
use the cursor keys to select 
the last file. 



Selecting a Single File
-----------------------------------------------------------------------------------------------
-----------

Click on the file that you want. If
the list is too long to fit in the 
box, use the scroll bar to move 
through it.

Press Alt+N and then Tab to 
access the list box, then use the
cursor keys to highlight a 
filename. 



Creating an Album

When you close the Album Title Dialog Box, Image Album 2.0 will open the Add Files By Dialog Box. You
use the dialog box to select one of two methods for adding files to the new album: 

 Selecting Files                 
 Scanning Directories

When you add files by scanning directories, you pick a directory, the type of media files that you want to 
add, and whether Image Album 2.0 should also scan any subdirectories. 

Select the Scanning Directories Option

Click on "Scanning Directories", then click on the OK Button. 

Press Alt+D, then press Enter. 

Image Album 2.0 will open the Select Directory Dialog Box. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the File Type

You select the file type from the File Type Drop Down Box. You cannot add animation files to an album if your system 
does not support animation. If you receive error messages, then either your system doesn't support animation, or 
your system is improperly configured. 

Set the Scan Sub-Directories Option

When the Scan Sub-Directories Option is turned on, Image Album 2.0 will search any sub-directories of the directory
that you selected in Step 3. Use the Scan Sub-Directories Check Box to set the Scan Sub-Directories Option.

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will perform the scan and add any files that matched your criteria to the 
new album.



Scan Sub-Directories Check Box
----------------------------------------------------
-----

----------------------------------------------------
-----
The Scan Sub-Directories Option is on 
when the check box is filled. To turn 
the option on or off:

Click on the text or the check box.

Press Alt+S.



Creating an Album

Access the Save As Dialog Box 

You use the Save As Dialog Box to save the album. To access the dialog box, you can select "Save" or "Save As" 
from the AlbumFile Menu, or you can:

Click on the Save Album File Button.

Press Ctrl+S. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box.

Enter the Filename

Image Album 2.0 automatically enters "UNTITLED.ALB" into the File Name Text Box. You enter a new name by typing 
over this text. Don't worry about typing the file extension - the ".ALB" at the end of the filename - Image Album 2.0 will
add it automatically. 

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will save the new album. 



File Formats

Image Album 2.0 directly supports thirty-seven different file formats: 

Twenty-four raster image formats

Nine meta and vector image formats

Two audio formats

Two animation formats

Image Album 2.0 can also support other file formats by using any external import filters that are available
on your system. 



File Formats

A raster format breaks an image into a grid of equally-sized pieces, called pixels, and records color 
information for each pixel. Image Album 2.0 supports twenty-four raster image formats:

Format Source/Standard Format Source/Standard

BMP/DIB OS/2 PCD Kodak Photo CD

BMP/DIB Windows PCX ZSoft Paintbrush 

CLP Windows Clipboard PGM UNIX

CUT Dr. Halo PIC Pictor/ PC Paint

ICO Windows Icon PNG Portable Network Graphics

IFF Electronic Arts PPM UNIX

IMG GEM Paint PSD Photoshop

JIF/JPG Joint Photo. Expert Group RAS Sun Microsystems

LBM Deluxe Paint RLE CompuServe or Windows 

MAC MacPaint TGA Truevision 

MSP Microsoft Paint TIFF Aldus (Non-LZW compressed)

 PBM UNIX WPG WordPerfect



BMP/DIB (OS/2)



BMP/DIB (Microsoft Windows)



CLP (Windows Clipboard)



CUT (Dr. Halo)



IFF (Electronic Arts)



IMG (GEM Paint)



JIF/JPG (Joint Photo Expert Group)



LBM (Deluxe Paint)



MAC (MacPaint)



MSP (Microsoft Paint)



PBM (UNIX)



PCD (Kodak Photo CD)



PCX (ZSoft Paintbrush)



PGM (UNIX)



PIC (Pictor / PC Paint)



PPM (UNIX)



PSD (Photoshop)



RAS (Sun Microsystems)



RLE (CompuServe, Windows)



TGA (Truevision)



TIFF (Aldus)



WPG (WordPerfect)



Bits-Per-Pixel and Color Depth
The number of colors that a raster file can contain is determined 
by the bits-per-pixel: the more information that is recorded for 
each pixel, the more shades and hues that the file can contain. 
Most raster formats support more than one level of bits-per-pixel, 
and therefore more than one level of color. The following table 
lists all of the bits-per-pixel ratios in the raster formats that Image
Album 2.0 supports.

Bits-Per-Pixel Maximum Number of Colors

1 2

4 16 

8 256 

16 32,768 or 65,536 (depends on format)

24 16,777,216 

32 16,777,216 



File Formats

In the strictest definition, a vector format can only contain vector information. In common practice, many 
formats that are considered to be vector allow the user to include non-vector data, such as raster images 
or text. Meta formats explicitly allow more than just vector data. For example, a metafile might contain a 
bitmap, vector information, and text.

When you use Image Album 2.0 to view a file that contains vector information, what you see is a raster 
image based on the vector data. Image Album 2.0 imports the vector image and converts it to an internal
raster format for viewing and for use in the file's thumbnail. Image Album 2.0 cannot write vector 
information. You can save files in the Windows metafile format (WMF), but the files only contain raster 
information. 

Format Source/Standard Read/Write
CDR CorelDRAW!

CGM Computer Graphics Metafile

DRW Micrografx Draw

DXF Autodesk

GEM Ventura / GEM

HGL Hewlett-Packard Graphics Language

PIC Lotus Development Corp.

WMF Windows Metafile*  *

WPG WordPerfect (Version 5.0 and 5.1)

* Image Album 2.0 cannot write vector information. When 
you save a file in the Windows metafile format, the file only 
contains raster information. 

Vector Information
Vector information is a collection of geometric 
shapes that combine to make an image. The 
information is recorded as mathematical formulas. 
Vector information has two advantages over raster 
information: it is scaleable without distortion (the 
"jaggies" that come with re-sizing a bitmap) and it 
produces smaller files.

Meta and Vector File Formats



File Formats

Image Album 2.0 reads and plays two audio formats:

Format Source/Standard

MID Musical Instrument Digital Interface
(Maintained by International MIDI Association)

WAV Microsoft Windows (Digital Audio)



File Formats

Image Album 2.0 reads and plays two animation formats:

Format Source/Standard

AVI Video For Windows

FLC/FLI Autodesk Animation

File Formats

In addition to the file types that Image Album 2.0 supports directly, it also supports any file types for 
which your system has external import filters. Most major software applications, such as Microsoft Word® 
or Lotus 1-2-3®, come with external import filters that are installed with the application. A common file type
that Image Album 2.0 can support via external import filters is Encapsulated Postscript. 

In Image Album 2.0's dialog boxes, the file types that are supported via external import filters have "EXT:"
after the file extension. For example, Encapsulated Postscript appears as "EPS - EXT: Encapsulated 
Postscript".



Getting Started

Image Album 2.0 is an archiving system for media files. You use Image Album 2.0 to organize your 
media files so that they are easier to find and use. Using Image Album 2.0 revolves around albums, 
thumbnails, and media files: 

An album is a collection of thumbnails.

A thumbnail represents a media file. 

A media file is an image, sound, or animation file.

This section of the help file provides general information about Image Album 2.0. If you have just 
installed Image Album 2.0, take a look around, then go create an album. You can't use any of Image 
Album 2.0's features until you do.

Starting Image Album 2.0

You start Image Album 2.0 by double-clicking on its icon. Where the icon is located depends on how 
you installed Image Album 2.0. If you used the default setup, the icon is in the Image Album 2.0 group 
in your Program Manager. When you start Image Album 2.0, it will open the Main Window.

Exiting Image Album 2.0
To exit Image Album 2.0, do one of the following:

Select "Exit" from the AlbumFile Menu

Press Alt+F4

Double-click on the Main Window's Control Box



Getting Started

You access all of Image Album 2.0's features from the Main Window. For help with a Main Window 
feature, click on it in the diagram below:



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

To get help with a menu selection, click on the menu's title in the diagram below, then click on the menu 
selection. 



Getting Started

There are several ways to get help with Image Album 2.0:

Manual
The printed manual is a "how to" reference. Feel free to skip the stuff you don't care about, and to jump to
topics that interest and concern you.

On-Line Help
The on-line help file (which you are currently using) presents most of the information in the printed manual
in an easy to use format. To access the on-line help, select "Index" from the Help Menu, or click on the 
Help Toolbar Button.

Help on Toolbar Buttons and Menu Items
When you highlight a menu selection or place the cursor over a toolbar button, the Status Bar displays a 
description of the associated command.

Technical Support
The manual and help file are designed to address the majority of user's questions. If they fail to solve your
problem, you can contact Parsons Technologys Technical Support department at 
1-319-395-7314.



Title Bar
-------------------------------------------------------------------------------------------------------------
------------

-------------------------------------------------------------------------------------------------------------
------------
The Main Window's Title Bar is a standard Windows title bar. As the name implies, 
it displays the program's name. If an album is open, its filename follows "Image 
Album 2.0", separated by a dash. In this example , WINDOWS.ALB is open.



Control Box
At the left end of the Title Bar is the Control Box, 
which you use to access the Control Menu. Double-
clicking on the Control Box closes Image Album 
2.0.
Control Menu
To open the Control Menu, click on the Control Box,
or press Alt+Spacebar. You can use the Control 
Menu to position the Main Window, to exit Image 
Album 2.0, or to access your system's task 
manager. You choose a menu selection by clicking 
on it, pressing its underlined letter, or using the 
cursor keys to highlight it and pressing Enter. 

Positioning Buttons
At the right end of the Title Bar are the Main Window's positioning buttons. When
the window is maximized, the Maximize Button is replaced by the Restore 
Button. 



Menu Bar

The menu bar contains Image Album 2.0's menus. Each menu lists a "family" of
selections, and each selection performs a specific action. 

You open a menu by clicking on it, or by pressing Alt plus the letter that is 
underlined in the menu's title. For example, to open the AlbumFile Menu, you 
would press Alt+F. You choose a menu selection by clicking on it, pressing its 
underlined letter, or using the cursor keys to highlight it and pressing Enter. 



Workspace
As the name implies, the Workspace is where 
you do your work. The Workspace displays 
the thumbnails in the current album. 



Status Bar
--------------------------------------------------------------------------------------------------------------------------
--------------

--------------------------------------------------------------------------------------------------------------------------
--------------
The Status Bar appears at the bottom of the Main Window. Like the example shown above, 
it usually displays the title of the current album, information about the selected thumbnails, 
and the current album size and free memory. 

When you highlight a menu selection or place the cursor over a toolbar button, the Status 
Bar displays a description of the associated command. When you are performing a task that 
takes a little time -- such as opening an album or converting an image file -- the right panel 
displays a dark gray bar that indicates how much of the procedure has been completed.



New Album File Button
Click here to create a new album.



Open Album Button
Click here to open an existing album.



Save Album Button
Click here to save to the current album.



Print Album Button
Click here to print some or all
of the album's thumbnails.



Print Image Button
Click here to print the selected image files.



Cut Image Button
Click here to cut the image for the 
selected thumbnail. Image Album 2.0
will send the image to the clipboard 
and delete the thumbnail from the 
album.



Copy Image Button
Click here to copy the image for the 
selected thumbnail to the clipboard.



Paste Image Button
Click here to paste the clipboard 
contents into a new image file.



Play/View Media File Button
Click here to play or view the 
selected thumbnail's media file.



Information Button
Click here to display information about 
the selected thumbnail's media file.



Run Slide Show Button
Click here to start a slide show.



Help Button
Click here to access the on-line 
Help that you are currently using.



"New"
Select "New" to create a new album.



"Open"
Select "Open" to open an album.



"Save"
Select "Save" to save the current album.



"Save As"
Select "Save As" to save a new album for the 
first time, or to make a copy of an existing 
album.



"Save Selected"
Select "Save Selected" to copy the 
selected thumbnails to a new album.



"Close"
Select "Close" to close the current album.



"Delete"
Select "Delete" to delete the current album.



"Merge"
Select "Merge" to merge two albums 
into a single album.



"Select"
Choose "Select" to select thumbnails by characteristic.



"Sort"
Select "Sort" to sort thumbnails by characteristic.



"Title"
Select "Title" to change the title of the current album.



Print Sub-Menu
Select "Print" to open the Print Sub-Menu.
Select "Album" to print thumbnails. Select
"Image" to print image files.



"Printer Setup"
Select "Printer Setup" to change your printer setup.



Preferences Sub-Menu
Select "Preferences" to open the Preferences Sub-Menu. Use the entries on
the Preferences Sub Menu to modify a variety of Image Album 2.0's 
settings.
-----------------------------------------------------------------------------------------------------
-----------



"Exit"
Selecting "Exit" closes Image Album 2.0. If you made
changes to the current album and haven't saved it, 
Image Album 2.0 will present the Save Changes 
Prompt.

To save the changes, click on the Yes Button, or 
press Alt+Y.

To close the album without saving the changes,
click on the No Button, or press Alt+N.

To return to Image Album 2.0 without closing 
the album, click on the Cancel Button, or press Esc.



Recently Used Files
The four most recently used albums are listed at
the bottom of the AlbumFile Menu. You can open
one of these albums by selecting its entry. 



"Cut"
Select "Cut" to cut the image for the 
selected thumbnail. Image Album 2.0
will send the image to the clipboard 
and delete the thumbnail from the 
album.



"Copy"
Select "Copy" to copy the image for the 
selected thumbnail to the clipboard.



"Paste"
Select "Paste" to paste the clipboard 
contents into a new image file.



"Add"
Select "Add" to add thumbnails to the current album.



"Delete"
Select "Delete" to remove thumbnails 
from the current album.



"Remove Orphans"
Select "Remove Orphans" to remove 
invalid thumbnails from the current 
album.



Update Thumbnails
Select "Update Thumbnails" to update thumbnail images.



"Comments"
Select "Comments" to add or edit a thumbnail's comments.



"Keywords"
Select "Keywords" to add or edit a thumbnail's keywords.



"Disk ID"
Select "Disk ID" to edit the disk ID for one or more 
thumbnails.



"Drive"
Select "Drive" to change the drive for one or more thumbnails.



"Drive & Directory"
Select "Drive & Directory" to change the drive 
and directory for one or more thumbnails.



"Keyword"
Select "Keyword" to search for thumbnails by keyword.



"Comment"
Select "Comment" to search for thumbnails by comment.



"File Name"
Select "File Name" to search for thumbnails by file name.



"Repeat Find"
Select "Repeat Find" to repeat the last search.



"Convert"
Select "Convert" to copy the selected thumbnails' 
image files to a different file format. 



"Copy"
Select "Copy" to copy the current thumbnail's 
media file to a different drive or directory. 



"Delete"
Select "Delete" to permanently delete 
the selected thumbnails' media files.



Edit Using Sub-Menu
Select "Edit Using" to open the Edit Using Sub-Menu. 
The sub-menu lists the primary editor for the selected 
thumbnail's file type (first entry) and any secondary 
editors (remaining entries). To open the media file in 
one of the editors, select the editor's entry. 



"Move"
Select "Move" to move the selected 
thumbnails' media files to a different 
drive or directory.



"Play/View"
Select "Play/View" to play or view 
the selected thumbnail's media file.



"Rename"
Select "Rename" to rename the 
selected thumbnail's media file.



"Stop Playing"
Select "Stop Playing" to stop playing an audio file.



"Album Info"
Select "Album Info" to display 
information about the current 
album.



"Media File Info"
Select "Media File Info" to display information 
about the selected thumbnail's media file.



"Comments"
Select "Comments" to view the current thumbnail's comments.



"Keywords"
Select "Keywords" to view the current thumbnail's keywords.



"Slide Show"
Select "Slide Show" to play and view media files as a slide show.



"Index"
Select "Index" to display the contents 
page of the on-line help that you are 
currently using.



"Using Help"
Select "Using Help" for an explanation 
of how to use Windows Help. 



"About"
Select "About" to display information about Image Album 
2.0.



Drive Drop Down Box
-------------------------------------------------------------------------------------------------
-----------

Click on the drop down box to open
it, then click on the drive that you 
want. If the list is too long to fit in 
the box, use the scroll bar to move 
through it.
Press Alt+V to access the drop 
down box, then press the drive 
letter.



Directories List Box
---------------------------------------------------------------------------------------
----------

Double-click on the directory 
or its folder icon. Use the 
scroll bars to move up and 
down the directory tree.
Press Alt+D to access the list
box, use the cursor keys to 
highlight the directory, then 
press Enter. 

---------------------------------------------------------------------------------------
----------
Please Note: If you are unfamiliar with directories and directory 

trees, see your Windows documentation. 



File Type Drop Down Box.
---------------------------------------------------------------------------------------------------------------
------------

Click on the drop down box to open it, 
then click on the file type that you want. 
If the list is too long to fit in the box, use 
the scroll bar to move through it.
Press Alt+T to access the drop down 
box. You use the cursor keys and letter 
keys to highlight a selection. Pressing a 
letter key once moves to the first format 
that begins with that letter. Pressing it 
again moves to the second.



File Name Text Box
---------------------------------------------
--------

---------------------------------------------
--------
To access the File Name Text 
Box:

Double-click in it to overwrite 
the current text, or click in it 
once to edit the text.

Press Alt+N.



File Name Combo Box
----------------------------------------------------------------------------------------------------------
------------

Click on the file's entry in the list box. If the list is 
too long to fit in the box, use the scroll bar to 
move through it.
Press Alt+N and then Tab to access the list box,
then use the cursor keys and letter keys to 
highlight the filename. Pressing a letter key once
moves to the first file that begins with that letter. 
Pressing it again moves to the second.



Album / Album File
An album is a collection of thumbnails. When
you save an album, you create an album file.



Thumbnail
The media files in an album are represented by thumbnails. A
graphic file thumbnail displays a reduced version of the file's 
image, an animation thumbnail displays the file's first frame, 
and an audio file thumbnail displays an icon for the file type. 
Thumbnails appear in the Main Window's Workspace.

Examples of Thumbnails



Current Thumbnail
The current thumbnail is the last thumbnail 
that you selected. Its filename will be 
highlighted.



Disk ID
A disk ID is a volume label for a removable 
medium, such as a diskette or a CD, where a 
media file is located. Image Album 2.0 
automatically records the disk ID when it creates 
a media file's thumbnail. 

Editing

Selecting Thumbnails By



Media File
A media file can be an image file, an audio 
file, or an animation file. Image Album 2.0 
directly supports thirty-seven file formats, and 
can utilize external import filters to support 
additional formats.

Standard File Formats

External Import Filters



Comments
You can add comments to thumbnails. Comments can
help you remember what a media file was created for, 
how good the file's quality is, and anything else that 
might be important. You can also search for 
comments, and you can select thumbnails based on 
their comments.

Adding and Editing

Searching For 

Selecting Thumbnails By

Viewing



Keywords
You can add keywords to thumbnails. 
You can search for keywords, and you 
can select thumbnails based on their 
keywords.

Adding and Editing

Searching For 

Selecting Thumbnails By

Viewing



Primary Mouse Button
On a two-button mouse, the primary button is the one 
that you use more often. For most users, it's the left 
button. If you're left-handed, your buttons may be 
reversed, in which case the primary button would be on 
the right.



Secondary Mouse Button
On a two-button mouse, the secondary button is the one 
that you use less often. For most users, it's the right 
button. If you're left-handed, your buttons may be 
reversed, in which case the secondary button would be 
on the left.



Media File Errors
You may receive an error message when you try to play a sound 
file, or when you try to add an animation file to an album. The 
typical problem is a missing device driver. If the error is cause by 
a sound file, you computer may not have a soundboard. 
Use the Control Panel's Drivers Option to install
the correct drivers for your system's sound and 
video devices. If this fails to solve the problem, 
or if the correct drivers are already installed, 
contact the manufacturer of your sound board, 
video board, or computer for technical support. 

Control Panel 
Icon

Drivers Option 
Icon
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Primary Editors
Primary editors are assigned to specific file extensions. When 
you install Image Album 2.0, it sets the primary editors to the 
applications that Windows associates with the file extensions 
that Image Album 2.0 recognizes. For example, if you use 
Micrografix Draw, then it is probably associated with the ".DRW"
file extension. If it is, then Draw will be the primary editor for 
files with that extension.

Selecting Primary Editors

Using Primary Editors



Secondary Editors
Secondary editors are not assigned to file 
extensions. While the primary editors are only 
available for the files with the associated 
extensions, secondary editors are available for all 
media files. The list of secondary editors remains 
empty until you add applications.

Selecting Secondary Editors

Using Secondary Editors



Image Files

You can view an image file by selecting "Play/View" from the MediaFile Menu, or you can:

Click on the Play/View Media File Button.

Double-click on the file's thumbnail.

Press Shift+V.

Image Album 2.0 will display the image full screen. To return to Image Album 2.0, click anywhere, or 
press any key. 



Image Files

You can print image files, or you can print thumbnails.

Select the Image Files' Thumbnails 

Select the thumbnails for the images that you want to print. 

Access the Print Image Dialog Box 

Click on the Print Image Button.

Select "Image" from the AlbumFile Print Sub-Menu. 
Press Alt+F, then P, and then I.

Set the Print Range

You can print the current thumbnail's file, or the files for all of the selected thumbnails. Use the Print Range Group 
Box to select an option.

Set the Print Quality

You set the print resolution from the Print Quality Drop Down Box.

Enter the Number of Copies (Optional)

If your printer supports multiple copies, you can print more than one copy of an image at a time. Type the number of 
copies that you want to print into the Copies Text Box. 

Change the Printer (Optional)

The current printer is listed at the top of the Print Image Dialog Box. If you want to select a different printer or change 
your printer setup, click on the Setup Button, or press Alt+S. 

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will send the image files to the printer. 



Print Range Group Box
------------------------------------------------------------------------------------------
----------

Click on the option's 
text or button.

Press Alt plus the 
option's underlined 
letter.



Image Files

Image files come in two types of file formats: raster formats and vector formats. You can convert any 
image file to a raster format, but you cannot convert a raster file to a vector format, and you cannot 
convert from one vector format to another. 

Select the Image Files' Thumbnails

Select the thumbnails for the images that you want to print. 

Select the Convert Command

You access the Convert Command by choosing "Convert" from the MediaFile Menu:

Click on "MediaFile" in the menu bar, then click on "Convert".

Press Alt+M, then press V.

If the file is in a raster format, Image Album 2.0 will open the Save As Dialog Box.

If the file is in a vector format, Image Album 2.0 will open the Meta Picture Import Dialog Box. After
you select a size for the converted image, Image Album 2.0 will open the Save As Dialog Box.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the Format

You select the format for the new file from the List Files of Type Drop Down Box.

Select the Sub-Format

If the file format you selected has sub-formats, you select the sub-format from the File Sub-Format Drop Down Box.

Enter the Filename

Image Album 2.0 automatically enters the original filename with the appropriate extension into the File Name Text 
Box. You enter a new name by typing over this text. You don't need to add the file extension. Image Album 2.0 will 
add it automatically.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will create the new file. If you selected more than one 
thumbnail, Image Album 2.0 will start over at Step 3.



File Sub-Format Drop Down Box
-------------------------------------------------------------------------------------------------------------
------------

Click on the drop down box to open it, then 
click on the sub-format that you want. If the 
list is too long to fit in the box, use the scroll 
bar to move through it.

Press Alt+S to access the drop down box. 
You use the cursor keys and letter keys to 
highlight a selection.



List Files of Type Drop Down Box
------------------------------------------------------------------------------------------------------------
------------

Click on the drop down box to open it, then
click on the file type that you want. If the 
list is too long to fit in the box, use the 
scroll bar to move through it.

Press Alt+T to access the drop down box. 
You use the cursor keys and letter keys to 
highlight a selection. Pressing a letter key 
will highlight the first format that begins 
with that letter. Pressing it again will 
highlight the second format.



Meta Picture Import Dialog Box
---------------------------------------------------------------------------------------------------------
-----------

To change the size and 
scale of the image, you 
edit the contents of the 
Width and Height Text 
Boxes. To access a text 
box, click in it, or press 
Tab until its text is 
highlighted. When you're 
done, click on the OK 
Button, or press Enter. 
Image Album 2.0 will 
open the Save As Dialog 
Box.



Vector Format
A vector format file is a collection of the 
shapes that combine to make the image, 
recorded as mathematical formulas.



Raster Format
A raster format file breaks an image into a 
grid of equally-sized pieces, called pixels, 
and records color information for each pixel. 



Image Files

You can use Window's clipboard to cut, copy, and paste images. 
 Edit Cut              
 Edit Copy           
 Edit Paste

The Edit Cut Command sends the image for the current thumbnail to the clipboard and removes the 
thumbnail from the album. The underlying image file is not affected in any way. You can use the Edit Cut 
Command by selecting "Cut" from the Edit Menu, or you can:

Click on the Edit Cut Button.

Press Ctrl+X.



Image Files

You can use Window's clipboard to cut, copy, and paste images. 
 Edit Cut              
 Edit Copy           
 Edit Paste

The Edit Copy Command sends the image for the current thumbnail to the clipboard and leaves the 
thumbnail intact. The underlying image file is not affected in any way. You can use the Edit Copy 
Command by selecting "Copy" from the Edit Menu, or you can:

Click on the Edit Copy Button.

Press Ctrl+C.



Image Files

You can use Window's clipboard to cut, copy, and paste images. 
 Edit Cut              
 Edit Copy           
 Edit Paste

The Edit Paste Command retrieves the contents of the clipboard and prompts you to save it to an image 
file. 

Select the Edit Paste Command 

You can select the Edit Paste Command by choosing "Paste" from the Edit Menu, or you can:

Click on the Edit Paste Button.

Press Ctrl+V.

Image Album 2.0 will open the Save As Dialog Box.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box.

Select the Format

You select the format for the new file from the List Files of Type Drop Down Box.

Select the Sub-Format

If the file format you selected has sub-formats, you select the sub-format from the File Sub-Format Drop Down Box.

Enter the Filename

Image Album 2.0 automatically enters the filename "new" with the new extension into the File Name Text Box. You 
enter a new name by typing over this text. You don't need to add the file extension. Image Album 2.0 will add it 
automatically.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will create the new file and add its thumbnail to the current 
album.



Image Files

You can use Image Album 2.0 as an OLE (Object Linking and Embedding) server for delivering images 
to another application's workspace. 

 Creating an Object          
 Editing an Object             
 Editing an Object's Image

The following steps are typical of most OLE applications. For more help, refer to the host application's 
documentation.

Position the Cursor in the Workspace

Place the cursor where you want the object to appear.

Access the Insert Object Command

In most applications, you access the Insert Object Command either by selecting "Insert Object" from the Edit Menu, 
or by selecting "Object" from the Insert Menu. The application will present its Insert Object Dialog Box.

Set the Object Type to Image Album 2.0 Image 

Choose "Image Album 2.0 Image" from the Object Type List Box.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will appear and will present the Open Album Dialog Box.

Select an Album

Use the Open Album Dialog Box to select an album. 

Select an Image File Thumbnail 

Double-click on the image file's thumbnail. If Image Album 2.0 was already open, it will minimize; if not, it will close. 
The application you started from will reappear, and the selected file's image will be inserted at the cursor. 



Image Files

You can use Image Album 2.0 as an OLE (Object Linking and Embedding) server for delivering images 
to another application's workspace. 

 Creating an Object          
 Editing an Object            
 Editing an Object's Image

When you edit an Image Album 2.0 object, you do not alter the image itself. Instead, you use Image 
Album 2.0 to select a new image, or to update the current image. 

Activate Image Album 2.0 from the OLE Object

How you activate Image Album 2.0 from the OLE object varies from application to application. In most applications, 
you can access Image Album 2.0 by:

Double-clicking on the object.

Highlighting the object, then selecting "Image 
Album 2.0 Image Object" from the Edit Menu.

Image Album 2.0 will activate and will open the album that you used to create the object. 

Select an Image File Thumbnail 

Double-click on the thumbnail for the new image that you want to display in the Image Album 2.0 object. 

To select a new image, double-click on its thumbnail. 

To update the current image, double-click on the image file's thumbnail. 
The application you started from will reappear, and the Image Album 2.0 object will display the new or revised 
image. 



Selecting a New Image
You can only select images from the album that 
was used to create the object. If you want to 
select an image from a different album, delete 
the existing object and create a new one. 



Updating the Current Image
An Image Album 2.0 object does not 
automatically reflect changes to the underlying 
image file. If you edit the image file and want the 
revised image to be displayed in your host 
application, you must use Image Album 2.0 to 
update the object. 



Image Files

You can use Image Album 2.0 as an OLE (Object Linking and Embedding) server for delivering images 
to another application's workspace. 

 Creating an Object          
 Editing an Object             
 Editing an Object's Image

When you edit an object's image, you use Image Album 2.0 to load the file into an editor, then you send 
the revised image back to the host application.

Activate Image Album 2.0 from the OLE Object

How you activate Image Album 2.0 varies from application to application. In most applications, you can access 
Image Album 2.0 by:

Double-clicking on the object.

Highlighting the object, then selecting "Image 
Album 2.0 Image Object" from the Edit Menu.

Edit the Image File

Edit the file in the editor that you prefer. When you're done, you don't have to close the editing program, but you must 
save the file. 

Update the Album's Thumbnails (Optional)

When you edit an image file, it's a good idea to update the album's thumbnails: 

Click on "Edit" in the menu bar, then click on "Update Thumbnails".

Press Alt+E, then press U.

Update the Object

Double-click on the image file's thumbnail. The application you started from will reappear, and the Image Album 2.0 
object will display the revised image. 



Media Files

Playing or Viewing a Single Media File
You can play or view a single media file by selecting "Play/View" from the MediaFile Menu, or you can:

Click on the Play/View Media File Button.

Double-click on the file's thumbnail.

Press Shift+V.

If everything is in working order, Image Album 2.0 will display the image or play the sound or animation. If
something goes wrong, it will display an error message. To close an image and return to Image Album 
2.0, click anywhere, or press any key.

Slide Shows
You can play media files in a slide show sequence. Image Album 2.0 includes extensive options for 
controlling the slide show, including the incorporation of sound elements. 
Starting a Slide Show
You can start a slide show by selecting "Slide Show" from the View Menu, or you can:

Click on the Slide Show Button.

Press Shift+S.

Advancing the Frame
If the frame doesn't advance automatically, you advance it manually by either pressing the spacebar, or by clicking 
once. 

Stopping a Slide Show
You stop a slide show by pressing Esc.



Media Files

Image Album 2.0 has two types of media file editors: primary editors and secondary editors. 

Tip: If you edit an image file, or if you edit the first frame of an animation file, it's a good idea to
 update the album's thumbnails.

Primary Editors
To load a media file in its primary editor:

Double-click on the file's thumbnail with the secondary mouse button. 

Use the cursor keys to highlight the thumbnail, then press Enter.

If there is no primary editor defined for the file type you selected, you will receive an error message.

Secondary Editors
To load a media file in a secondary editor, you select "Edit Using" from the MediaFile Menu, then select 
an editor from the sub-menu:

Click on "MediaFile" in the menu bar, click on "Edit Using" in the 
MediaFile Menu, then click on an editor in the sub-menu.
Press Alt+M, press E, then press the editor's underlined letter.



Media Files

Select the Media Files' Thumbnails 

Select the thumbnails for the media files that you want to copy. 

Access the Copy To Dialog Box 

To access the Copy To Dialog Box, select "Copy" from the MediaFile Menu. 

Click on "MediaFile" in the menu bar, then click on "Copy".

Press Alt+M, then press C.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will copy the media files to the selected drive and directory.



Media Files

Select the Media Files' Thumbnails 

Select the thumbnails for the media files that you want to move. 

Access the Move To Dialog Box 

To access the Move To Dialog Box, select "Move" from the MediaFile Menu.

Click on "MediaFile" in the menu bar, then click on "Move".

Press Alt+M, then press M.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will move the media files to the selected drive and 
directory. 



Media Files

Select the Media File's Thumbnail 

Click on the thumbnail, or use the cursor keys to highlight it.

Access the Rename Dialog Box 

You access the Rename Dialog Box by selecting "Rename" from the MediaFile Menu. 

Click on "MediaFile" in the menu bar, then click on "Rename".

Press Alt+M, then R.

Enter the New Filename

Type the new filename into the text box. The name must follow the standard "eight-dot-three" filename convention: a 
name of up to eight characters, followed by a "." and a file extension of up to three characters. 

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will rename the media file. 



Media Files

Select the Media Files' Thumbnails 

Select the thumbnails for the media files that you want to delete. 

Select the Delete Media File Command

Click on "MediaFile" in the menu bar, then click on "Delete".

Press Ctrl+Delete.

Select "Yes" at the Delete Prompt

Image Album 2.0 will present a delete prompt. Click on the Yes Button, or press Enter. Image Album 2.0 will delete 
the media files and remove the thumbnails from the current album.

Tip: If you have thumbnails for the deleted files in another album or albums, you can use the 
Remove Orphans Command to remove those thumbnails. 



Media Files

To view information about a media file, start by highlighting its thumbnail:

Click on the thumbnail. 

Use the cursor keys to highlight the thumbnail.

Once you have highlighted the thumbnail, you can select "Media File Info" from the View Menu, or you can:

Click on the View Information Button. 

Press Shift+I.

Image Album 2.0 will open the Media File Information Dialog Box. The information displayed varies with the media 
file type. To close the dialog box, click on the OK Button, or press Enter. 



Customizing Your Setup

Accessing the General Setup Dialog Box 
You set the general settings from the General Setup Dialog Box. You access the dialog box by selecting 
"General" from the AlbumFile Preferences Sub-Menu:

Click on "AlbumFile" in the menu bar, click on "Preferences" in 
the AlbumFile Menu, then click on "General" in the sub-menu.
Press Alt+F, then F, and then G.

Selecting Options
An option is selected when its check box is filled in. To turn an option on or off: 

Click on the option's text or check box.

Press Alt plus the option's underlined letter.

Load the Last Album
When Image Album 2.0 starts, automatically load the last album used in the previous session.

Update the Thumbnails
When opening an album, automatically update the thumbnail images to reflect any changes in the 
underlying image and animation files.

Remove Orphans
When opening an album, automatically remove any thumbnails for media files that are no longer valid. 
Files will become invalid if they are moved to another drive or directory, or are deleted.

Double the Movie Size
Doubles height and width of animation images.

Image Viewing
Select one of the three options: 

No Scaling - All images will be displayed using their normal size. Images that are larger than the full screen will 
have parts of them off the screen.

If Larger, Shrink to Full Screen - Images that are smaller than the screen will be displayed with no scaling. 
Images that are larger than the screen will be decreased in size.

Scale All to Full Screen - All images will be resized to fit the full screen. Images that are smaller than the full 
screen will be increased in size. Images that are larger than the full screen will be decreased in size. Since 
Image Album 2.0 uses a raster format for displaying images, images that are increased substantially will be 
jagged. 

Display all Error Messages
Display error messages for all errors, whether generated by Image Album 2.0 or by your system. 





Customizing Your Setup

Image Album 2.0 has two types of media file editors: primary editors and secondary editors. 
 Primary Editors               
 Secondary Editors           
 Select Editor Dialog Box

Access the Primary Editors Setup Dialog Box 

You access the Primary Editors Setup Dialog Box by selecting "Primary Editors" from the AlbumFile Preferences Sub-
Menu: 

Click on "AlbumFile" in the menu bar, click on "Preferences" in the 
AlbumFile Menu, then click on "Primary Editors" in the sub-menu.
Press Alt+F, then F, and then P.

Select the File Extension

You select the file extension from the File Type List Box.

Enter or Delete the Editor Name

Use the Editor Name Text Box to enter or delete the editor name.

Enter or Delete the Program File Name

If you are adding or changing a primary editor, you can type the application's full path (drive, 
directory, and filename) into the Program Text Box, or you can use the Select Editor Dialog Box. 

If you are removing a primary editor, delete the contents of the text box

Add or Remove More Editors (Optional)

To add or remove additional editors, repeat Step 2 through Step 4 for each editor.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will save the new list of primary editors. 



File Type List Box
----------------------------------------------------------------------------------
---------

Click on an file type to 
select it. Use the scroll 
bar to move through 
the list.

Use the cursor keys 
and/or letter keys to 
select a file type. 



Program Text Box
---------------------------------------------------------------
-------

---------------------------------------------------------------
-------

If you are adding or changing the primary
editor, type the application's full path (drive, 
directory, and filename) into the Program Text 
Box. You access the text box by clicking in it or 
by pressing Alt+P.

If you are removing the primary editor, 
delete the contents of the text box. Press Alt+P,
then press Delete (or Del).



Editor Name Text Box
------------------------------------------------------------------
--------

------------------------------------------------------------------
--------

If you are adding or changing the primary 
editor, type the application's name into the Editor 
Name Text Box. You access the text box by 
clicking in it or by pressing Alt+E.

If you are removing the primary editor, 
delete the contents of the text box. Press Alt+E, 
then press Delete (or Del).



Customizing Your Setup

Image Album 2.0 has two types of media file editors: primary editors and secondary editors. 
 Primary Editors                
 Secondary Editors          
 Select Editor Dialog Box

Access the Secondary Editors Setup Dialog Box 

You access the Secondary Editors Setup Dialog Box by selecting "Secondary Editors" from the AlbumFile 
Preferences Sub-Menu: 

Click on "AlbumFile" in the menu bar, click on "Preferences" in the 
AlbumFile Menu, then click on "Secondary Editors" in the sub-menu.
Press Alt+F, then F, and then E.

Enter or Delete the Editor Name

Use an Editor Name Text Box to enter or delete the editor name.

Enter or Delete the Program File Name

If you are adding or changing a secondary editor, use the Select Editor Dialog Box. 

To remove a secondary editor, click on the appropriate Clear Button, or press Alt plus the Clear 
Button's underlined letter. 

Add or Remove More Editors (Optional)

To add or remove additional editors, repeat Steps 2 and 3 for each editor.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will save the new list of secondary editors. 



Editor Name Text Box (Example)
------------------------------------------------------------------------------------
----------

------------------------------------------------------------------------------------
----------

If you are adding or changing a secondary editor, type 
the application's name into the appropriate Editor Name Text 
Box. You access the text box by clicking in it, or by pressing Alt 
plus the underlined letter in the "Editor Name" label.

If you are removing a secondary editor, delete the 
contents of the text box. Press Alt plus the underlined letter in 
the "Editor Name" label, then press Delete (or Del).



Customizing Your Setup

Image Album 2.0 has two types of media file editors: primary editors and secondary editors. 
 Primary Editors                
 Secondary Editors           
 Select Editor Dialog Box

You can use the Select Editor Dialog Box to add a primary editor or a secondary editor. 

Access the Select Editor Dialog Box

Select the appropriate Browse Button. You can click on it, or you can press B plus the button's underlined number. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box.

Select the Directory

You change the directory from the Directories List Box.

Select the Application File

You select the application file from the File Name Combo Box.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will enter the application file's full path in the appropriate 
text box.



File Name Combo Box
----------------------------------------------------------------------------------------------------------
------------

Click on the file's entry in the list box. If the list is 
too long to fit in the box, use the scroll bar to 
move through it.
Press Alt+N and then Tab to access the list box,
then use the cursor keys and letter keys to 
highlight the filename. Pressing a letter key once
moves to the first file that begins with that letter. 
Pressing it again moves to the second.



Customizing Your Setup

You can control the size of the thumbnails, and the color of selected thumbnails.
 Thumbnail Size                
 Thumbnail Selection Color

Access the Thumbnail Size Dialog Box

You change the thumbnail size from the Thumbnail Size Dialog Box. To access the dialog box, select "Thumbnail 
Size" from the AlbumFile Preferences Sub-Menu:

Click on "AlbumFile" in the menu bar, click on "Preferences" in the 
AlbumFile Menu, then click on "Thumbnail Size" in the sub-menu.
Press Alt+F, then F, and then H.

Select a Size Option

To select a size option:

Click on the option's text or button.

Press Alt plus the option's underlined letter.



Customizing Your Setup

You can control the size of the thumbnails, and the color of selected thumbnails.
 Thumbnail Size                
 Thumbnail Selection Color

The thumbnail selection color is the color that Image Album 2.0 uses to highlight selected thumbnails. 
When you first install Image Album 2.0, the color is set to blue. You change the thumbnail selection color 
from the Color Dialog Box. To access the dialog box, select "Thumbnail Selection Color" from the 
AlbumFile Preferences Sub-Menu:

Click on "AlbumFile" in the menu bar, click on "Preferences" in the AlbumFile 
Menu, then click on "Thumbnail Selection Color" in the sub-menu.
Press Alt+F, then F, and then T.

Selecting a Color with the Mouse
There are two color controls for selecting a color with the mouse: the Crosshair Control in the Large Color
Box, and the Pointer Control for the Small Color Box. The controls affect the contents of the Color/Solid 
Display Box (see below). 

Selecting a Color with the Keyboard
Unless you know the numerical values for the color you want, it is much easier to use the mouse to select
a color. To select the color with the keyboard, type the RGB Values or the Hue, Saturation and Luminosity
values into the appropriate text boxes.

Color vs. Solid
The color in the left half of the Color/Solid Display Box is the setting that is used by Image Album 2.0. If 
you prefer the hue that appears in the Solid side, double-click on it, or press Alt+O. The Color side will be 
adjusted to match the Solid side. If your video display is showing 16 million colors, the two sides will 
appear the same.



Color Controls
You can move the crosshair control or
the slide control by dragging them to 
a new location, or you can just click 
where you want the control to go.
--------------------------------------------------
------

Crosshair Control Slide Control 



Customizing Your Setup

You use the Print Setup Dialog Box to customize your print settings. To access the dialog box, select 
"Printer Setup" from the AlbumFile Menu.

 Printer                
 Orientation         
 Paper  
 Printer Options

You can select the default printer, or you can select any of the other printers that are available to your 
system. 

Default Printer
To select the default printer, click on "Default Printer" or the associated option button, or press Alt+D. The 
default printer is a Windows setting. You can change the default printer from the Control Panel's Printers 
Option. 

Specific Printer
Use the Specific Printer Drop Down Box to select any of the available printers:

Click on the drop down box to open it, then click on the printer that
you want to select.
Press Alt+P, then ¯. Image Album 2.0 will open the drop down 
box. Use the cursor keys and/or letter keys to highlight the printer 
that you want to select. To close the drop down box, press Tab.



Specific Printer Drop Down Box



Control Panel's Printers Option
You use the Control Panel's Printers
Option to change the default printer. 

Control Panel 
Icon

Printers Option 
Icon



Customizing Your Setup

You use the Print Setup Dialog Box to customize your print settings. To access the dialog box, select 
"Printer Setup" from the AlbumFile Menu.

 Printer                
 Orientation         
 Paper  
 Printer Options

You use the Orientation Group Box to choose between the two different page orientations, portrait and 
landscape. Portrait is taller than it is wide, and landscape is wider than it is tall. 

On a standard piece of paper, printing in portrait orientation will place the image with its top toward one of 
the long sides, and printing in landscape orientation will place the image with its top toward one of the 
short sides. 

To select an orientation:

Click on its text or the associated option button.

Press Alt plus the option's underlined letter. 



Orientation Group Box



Customizing Your Setup

You use the Print Setup Dialog Box to customize your print settings. To access the dialog box, select 
"Printer Setup" from the AlbumFile Menu.

 Printer                
 Orientation         
 Paper                  
 Printer Options

Which paper size and source options are available is determined by the printer you have selected . You 
select the size from the Paper Size Drop Down Box and the source from the Paper Source Drop Down 
Box. For some printers, one or both of the drop down boxes may be unavailable. To select a size or 
source setting:

Click on the drop down box to open it, then click on the setting that you want to select. 

Press Alt plus the label's underlined letter (either Z or S), then press ¯ to open the drop down 
box. Use the cursor keys and/or letter keys to highlight the setting that you want to select. To 
close the drop down box, press Tab.



Paper Source Drop Down Box



Paper Size Drop Down Box



Customizing Your Setup

You use the Print Setup Dialog Box to customize your print settings. To access the dialog box, select 
"Printer Setup" from the AlbumFile Menu.

 Printer                
 Orientation         
 Paper  
 Printer Options

To set printer-specific options, click on the Options Button, or press Alt+O. Image Album 2.0 will open a 
dialog box that is specific to the software or driver that operates the selected printer. For help using the 
dialog box, try pressing F1, selecting the Help Button (if there is one), or referring to the appropriate 
documentation.



Customizing Your Setup

You set the options for slide shows from the Slide Show Setup Dialog Box. You access the dialog box by 
selecting "Slide Show Setup" from the AlbumFile Preferences Sub-Menu:

Click on "AlbumFile" in the menu bar, click on "Preferences" in the 
AlbumFile Menu, then click on "Slide Show Setup" in the sub-menu.
Press Alt+F, then F, and then S.

Advance Frame
You use the Advance Frame Group Box to control when the next media file will play. There are two 
settings for manually advancing the frame (Space Bar and Left Mouse Button) and one for automatic 
advancement. If you select the Time in Seconds Setting, enter the number of seconds in the Time in 
Seconds Text Box. The number can be an integer from one to six hundred. Image Album 2.0 will display 
each image for the minimum of (a) the amount of time entered here, or (b) the amount of time it takes to 
process the next image. 

Repeat
You use the Repeat Group Box to control how many times the slide show will play. You can repeat the 
show indefinitely (Until Esc Pressed), or you can specify a fixed number of times (Repeat Times Setting). 
If you select the Repeat Times Setting, enter the number of repetitions in the text box. The number can be
an integer between zero and one thousand (1 to 999). 

Other Options
The remaining options control a variety of slide show qualities. Use the Options Group Box to set these 
options. An option is selected when its check box is filled in. To turn an option on or off: 

Click on the option's text or check box.

Press Alt plus the option's underlined letter.

Display Error Messages
Display error messages generated by media files. 

Start at Current
Start slide show at the file for the thumbnail that was most-recently selected. 

Display Selected Only
Limit slide show to the files for the selected thumbnails. 

Use Effects
Apply various fade-in effects to image files.

Play CD in Background
Plays an audio CD in the background. Sound files in the album play over the CD, in the foreground. Enter 
the track that the CD should start at in the text box.



Associate Wav Files
If a WAV file is followed by an image file, the WAV file is played while the image file is displayed. The 
image file is displayed until the frame is advanced or the WAV file is done playing, whichever comes last.

Image Size 
Select one of the three options: 

No Scaling - All images will be displayed using their normal size. Images that are larger than the full screen will 
have parts of them off the screen.

If Larger, Shrink to Full Screen - Images that are smaller than the screen will be displayed with no scaling. 
Images that are larger than the screen will be decreased in size.

Scale All to Full Screen - All images will be resized to fit the full screen. Images that are smaller than the full 
screen will be increased in size. Images that are larger than the full screen will be decreased in size. Since 
Image Album 2.0 uses a raster format for displaying images, images that are increased substantially will be 
jagged. 



Advance Frame Group Box
---------------------------------------------------------------------
-------

Click on the 
option's text or 
button.

Press Alt plus the 
option's underlined
letter.



Repeat Group Box
------------------------------------------------------------------------
--------

Click on the option's 
text or button.

Press Alt plus the 
option's underlined 
letter.



Options Group Box (Example)



Customizing Your Setup

You use the AlbumFile Preferences Sub-Menu to show or hide the toolbar. You hide it by selecting "Hide 
Toolbar", and you display it by selecting "Show Toolbar":

Click on "AlbumFile" in the menu bar, click on "Preferences" in the AlbumFile 
Menu, then click on "Hide Toolbar" or "Show Toolbar" in the sub-menu.
Press Alt+F, then F, and then O.



Thumbnails

 Adding and Editing         
 Viewing

To add comments to a thumbnail, or to edit a thumbnail's comments, follow these steps:

Select the Thumbnail

Click on the thumbnail. 

Use the cursor keys to highlight the thumbnail.

Access the Edit Comments Dialog Box

You open the Edit Comments Dialog Box by selecting "Comments" from the Edit Menu:

Click on "Edit" in the menu bar, then click on "Comments".

Press Alt+E, then press M.

Enter the Text

Type your comments into the text box. You can use the standard Windows commands to edit the text.

Select the OK Button 

When you're done entering your comments, click on the OK Button, or press Enter. Image Album 2.0 will close the 
Edit Comments Dialog Box and save your comments.



Thumbnails

 Adding and Editing          
 Viewing

To view the comments for a thumbnail:

Click on "View" in the menu bar, then click on "Comments".

Press Shift+C.

Image Album 2.0 will open the View Comments Dialog Box. When you have finished reading the thumbnail's 
comments, click on the OK Button, or press Enter.



Thumbnails

You use keywords to search for thumbnails. 
 Adding and Editing         
 Viewing Keywords

Select the Thumbnail

Click on the thumbnail. 

Use the cursor keys to highlight the thumbnail.

Access the Edit Keywords Dialog Box 

You open the Edit Keywords Dialog Box by selecting "Keywords" from the Edit Menu:

Click on "Edit" in the menu bar, then click on "Keywords".

Press Alt+E, then press K.

Enter or Edit the Text

Type the keywords into the Keyword Text Boxes. You can use the standard Windows commands to edit the text. 

Select the OK Button 

When you're done entering your keywords, click on the OK Button, or press Enter. Image Album 2.0 will close the 
Edit Keywords Dialog Box and save the keywords.



Keyword Text Boxes (Examples)
--------------------------------------------------------
--------

--------------------------------------------------------
--------
To access a text box:

Click in it.

Press Alt plus the text box's underlined 
number, or press Tab or Shift+Tab until 
you reach the text box. 



Thumbnails

You use keywords to search for thumbnails. 
 Adding and Editing          
 Viewing

To view the keywords for a thumbnail:

Click on "View" in the menu bar, then click on "Keywords".

Press Shift+K.

Image Album 2.0 will open the View Keywords Dialog Box. When you have finished checking the thumbnail's 
keywords, click on the OK Button, or press Enter. 



Thumbnails

You can edit a thumbnail's disk ID, drive, or drive and directory. 
 Disk ID                
 Drive     
 Drive and Directory 

Select the Thumbnails

If you want to edit specific thumbnails, select them now. 

If you want to change the file location information for every thumbnail with the same invalid 
information, select any thumbnail that has the old information. 

Access the Change Disk ID Dialog Box 

You use the Change Disk ID Dialog Box to enter the new disk ID. To access the dialog box, select "Disk ID" from the 
Edit Menu:

Click on "Edit" in the menu bar, then click on "Disk ID".

Press Alt+E, then press I.

Enter the New ID

Type the new disk ID into the To Text Box. 

Select the Thumbnails Option

You can change the disk ID for the current thumbnail, the selected thumbnails, or all thumbnails in the current album 
that have the old disk ID. Use the Thumbnail Option Buttons to select an option.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will close the Change Disk ID Dialog Box and change the 
file information for the appropriate thumbnails.



Thumbnail Option Buttons
-----------------------------------------------------
------

-----------------------------------------------------
------

Click on the text or its option button.

Press Alt plus the option's underlined 
letter. 



To Text Box
-----------------------------------------------------
-----

-----------------------------------------------------
-----
To access the text box:

Click in it. Press Alt+T.



Thumbnails

You can edit a thumbnail's disk ID, drive, or drive and directory. 
 Disk ID                
 Drive  
 Drive and Directory 

Select the Thumbnails

If you want to edit specific thumbnails, select them now. 

If you want to change the file location information for every thumbnail with the same invalid 
information, select any thumbnail that has the old information. 

Access the Change Drive Dialog Box 

You use the Change Drive Dialog Box to enter the new drive. To access the dialog box, select "Drive" from the Edit 
Menu:

Click on "Edit" in the menu bar, then click on "Drive".

Press Alt+E, then press V.

Enter the New Drive

Type the new drive into the To Text Box. 

Select the Thumbnails Option

You can change the drive for the current thumbnail, the selected thumbnails, or all thumbnails in the current album 
that have the old drive. Use the Thumbnail Option Buttons to select an option.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will close the Change Drive Dialog Box and change the file
information for the appropriate thumbnails.



To Text Box
-----------------------------------------------------
-----

-----------------------------------------------------
-----
To access the text box:

Click in it. Press Alt+T.



Thumbnails

You can edit a thumbnail's disk ID, drive, or drive and directory. 
 Disk ID                
 Drive     
 Drive and Directory 

Select the Thumbnails

If you want to edit specific thumbnails, select them now. 

If you want to change the file location information for every thumbnail with the same invalid 
information, select any thumbnail that has the old information. 

Access the Change Drive and Directory Dialog Box 

You use the Change Drive and Directory Dialog Box to select the new drive and directory. To access the dialog box, 
select "Drive & Directory" from the Edit Menu:

Click on "Edit" in the menu bar, then click on "Drive & Directory".

Press Alt+E, then press E.

Select the Thumbnails Option

You can change the drive and directory for the current thumbnail, the selected thumbnails, or all thumbnails in the 
current album that have the old drive and directory. Use the Thumbnail Option Buttons to select an option.

Select the Disk Drive

You select the disk drive from the Drive Drop Down Box. 

Select the Directory

You select the directory from the Directories List Box.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will close the Change Drive and Directory Dialog Box and 
change the file information for the appropriate thumbnails.



Thumbnails

There are two methods for adding thumbnails to an album: 
 Selecting Files                 
 Scanning Directories

When you add files by selecting them, you pick individual files from a single directory. 

Access the Add Files By Dialog Box 

You use the Add Files By Dialog Box to select a method for adding files. To access the dialog box: 

Click on "Edit" in the menu bar, then click on "Add".

Press Ctrl+A.

Select the Selecting Files Option

Click on "Selecting Files", then click on the OK Button. 

Press Alt+F, then press Enter. 

Image Album 2.0 will open the Add Files Dialog Box. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the File Type

You select the file type from the File Type Drop Down Box. You cannot add animation files to an album if your system 
does not support animation. If you receive error messages, then either your system doesn't support animation, or 
your system is improperly configured. 

Select the Files

You select the files from the File Name Combo Box. You can select a single file, a sequential group of files, or a non-
sequential group of files. 

Select the OK Button

Click on it, or press Enter. Image Album 2.0 will add the selected files to the album.



Thumbnails

There are two methods for adding thumbnails to an album: 
 Selecting Files                 
 Scanning Directories

When you add files by scanning directories, you pick a directory, the type of media files that you want to 
add, and whether Image Album 2.0 should also scan any subdirectories. 

Access the Add Files By Dialog Box 

You use the Add Files By Dialog Box to select a method for adding files. To access the dialog box: 

Click on "Edit" in the menu bar, then click on "Add".

Press Ctrl+A.

Select the Scanning Directories Option

Click on "Scanning Directories", then click on the OK Button. 

Press Alt+D, then press Enter. 

Image Album 2.0 will open the Select Directory Dialog Box. 

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box. 

Select the File Type

You select the file type from the File Type Drop Down Box. You cannot add animation files to an album if your system 
does not support animation. If you receive error messages, then either your system doesn't support animation, or 
your system is improperly configured. 

Set the Scan Sub-Directories Option

When the Scan Sub-Directories Option is turned on, Image Album 2.0 will search any sub-directories of the directory
that you selected in Step 3. Use the Scan Sub-Directories Check Box to set the Scan Sub-Directories Option.

Select the OK Button 

Click on it, or press Enter. Image Album 2.0 will perform the scan and add any files that matched your criteria to the 
new album.



Thumbnails

Please Note: You cannot "undo" deleted thumbnails. If you accidentally remove thumbnails, or 
decide that you want to put the thumbnails back into the album, you must use the Edit Add 
Command.

Deleting Selected Thumbnails
To remove thumbnails from an album, start by selecting them. When you have selected the thumbnails 
that you want to delete:

Click on "Edit" in the menu bar, then click on "Delete".

Press Del or Delete.

Deleting Invalid Thumbnails 
If you use another application (such as File Manager) to move media files, any thumbnails for those files 
will retain the old file location information and will therefore become invalid. You can correct invalid 
thumbnails by editing their file location information, or you can remove them. Select "Remove Orphans" 
from the Edit Menu:

Click on "Edit" in the menu bar, then click on "Remove Orphans".

Press Alt+E, then press R.



Thumbnails

You select thumbnails in order to perform a task on the thumbnails themselves, or in order to perform a 
task on the underlying media files. 

 Specific Thumbnails       
 By Characteristic

Single Thumbnail

Click on it. If it doesn't appear in the Workspace, use the scroll bars to see the rest of the 
thumbnails. 

Use the cursor keys to highlight it.

Sequential Group of Thumbnails

Click on the first thumbnail in the sequence, then press and hold Shift while you click on 
the last thumbnail. 

Use the cursor keys to highlight the first thumbnail, then press and hold Shift while you use
the cursor keys to select the last thumbnail.

Non-Sequential Group of Thumbnails

Press and hold Ctrl while you click on the thumbnails. 

You can a select a non-sequential group of thumbnails with the keyboard, but you cannot 
select a non-contiguous group. Use the cursor keys to highlight the first thumbnail, then 
press and hold Ctrl while you use the cursor keys to select the rest of the thumbnails.

All Thumbnails
To select all of the thumbnails in the current album, press Home, then press 
Shift+End.



Thumbnails

You select thumbnails in order to perform a task on the thumbnails themselves, or in order to perform a 
task on the underlying media files. 

 Specific Thumbnails       
 By Characteristic

You use the Select Command to select all of an album's thumbnails that have a specific characteristic. 

Access the Select Dialog Box 

You open the Select Dialog Box by choosing "Select" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Select".

Press Alt+F, then press E.

Select the Characteristic

Select the characteristic that you want the thumbnails to match from the Select Based On Drop Down Box.

Enter the Characteristic's Setting

Type the characteristic's setting into the Equal To Text Box.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will select the thumbnails with the characteristic setting that
you specified.



Pixel Characteristics
Raster file formats break an image into a grid of 
equally-sized pieces, called "pixels". Since Image 
Album 2.0 converts vector information into an 
internal raster format, all image file thumbnails, 
even those for meta and vector files, contain pixel 
characteristics. 

Meta and Vector File Formats

Raster File Formats 



Equal To Text Box
-----------------------------------------------------
------

-----------------------------------------------------
------
To access the text box:

Click in it. Press Alt+E.



Select Based On Drop Down Box
---------------------------------------------------------------------------------------------------------
-----------

Click in the drop down box to open it, then 
click on the characteristic that you want to 
select.

Press Alt+S to access the drop down box. 
Use the cursor keys and/or letter keys to 
highlight a selection. 

---------------------------------------------------------------------------------------------------------
-----------
Disk ID: A volume label for a removable 
media, such as a diskette or a CD. 

Drive: The drive where the media file is 
located.

Drive and Directory: The drive and 
directory where the media file is located.

Filename: The file's name, including the 
extension, in the eight-dot-three format.

Extension: The file's extension, without the 
period (".").

Width: An image file's width in pixels.

Height: An image file's height in pixels.

Bits Per Pixel: The number of bits per 
pixel in an image. 

Comments: The comments attached to the
thumbnail. 

Keywords: The keywords attached to the 
thumbnail. 



Thumbnails

You can move individual thumbnails by dragging-and-dropping, or you can sort the entire album.
 Dragging-and-Dropping                
 Sorting

Grab the Thumbnail 

You grab a thumbnail by pointing at it with the mouse and pressing and holding the primary mouse button. The 
cursor will change to an arrow over a tiny page.

Drag the Thumbnail 

You drag the thumbnail to its new position by moving the mouse. Place the cursor over the thumbnail that you want to
precede the one you're dragging. For example, if you want to move the thumbnail to the end of the album, place it 
over the thumbnail that is currently last.

Drop the Thumbnail 

You drop the thumbnail by releasing the mouse button. Image Album 2.0 will rearrange the thumbnails so that the 
one you dragged-and-dropped is in the position that you selected.



Thumbnails

You can move individual thumbnails by dragging-and-dropping, or you can sort the entire album.
 Dragging-and-Dropping                
 Sorting

You can sort an album's thumbnails so that they appear in ascending or descending order according to 
ten characteristics. Each sort acts upon the results of the previous sort. For example, sorting by filename 
and then by disk ID arranges the thumbnails so that they are grouped by disk ID, and within each disk ID 
grouping, by filename. 

Access the Sort Dialog Box 

You use the Sort Dialog Box to perform a sort. To access the dialog box, select "Sort" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Sort".

Press Alt+F, then press T.

Select the Sort Order

You can sort the images in ascending or descending order. Use the Sort Order Group Box to select an order.

Select the Sort Criterion

There are ten different ways to sort the thumbnails. Use the Criterion Option Buttons to select one.

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will sort the album according to the order and criteria that 
you selected. 



Sort Order Group Box
----------------------------------------------------------------------------------
---------

Click on the option's text or button.

Press Alt plus the option's underlined 
letter.



Criterion Option Buttons
----------------------------------------------------------------------------------------
----------

Click on the 
criterion's text or 
button.

Press Alt plus the 
criterion's 
underlined letter.



Thumbnails

You can copy some or all of an album's thumbnails to a new album. 

Select the Thumbnails

Select the thumbnails you would like to include in the new album. 

Access the Save As Dialog Box 

To access the Save As Dialog Box, select "Save Selected" from the AlbumFile Menu:

Click on "AlbumFile" in the menu bar, then click on "Save Selected".

Press Alt+F, then press V.

Select the Disk Drive

You change the disk drive from the Drive Drop Down Box. 

Select the Directory

You change the directory from the Directories List Box.

Enter the Filename

Image Album 2.0 automatically enters the current filename into the File Name Text Box. You enter a new name by 
typing over this text. Don't worry about the file extension - the ".ALB" at the end of the filename - Image Album 2.0 will
add it automatically.

Select the OK Button

Click on the OK Button, or press Enter. Image Album 2.0 will create the new album and fill it with the selected 
thumbnails.



Thumbnails

You can search for a thumbnail based on its comments, keywords, or filename. 

Select the Search Type

With the exception of keywords, you must use the Find Menu to select the search type:

Click on "Find" in the menu bar, then click on the type of search that you 
want to perform.
To select keywords, press Alt+F3. To select another type of search, press
Alt+N, then press the search type's underlined letter.

Enter the Search Text

When you select a search type, Image Album 2.0 will open the Find Dialog Box. Type the text that you want to 
search for into the text box. To access the text box, click in it, or press Alt+N. You can search for partial text. For 
example, you can search for all thumbnails with comments that contain the word "draft".

Set the Match Case Option

When the Match Case Option is on, Image Album 2.0 ignores text that does not have the same upper and lower 
case as the text that you enter. Use the Match Case Check Box to set the option. 

Select the OK Button 

Click on the OK Button, or press Enter. Image Album 2.0 will perform the search. 

If Image Album 2.0 finds a thumbnail with matching text, it will highlight the thumbnail. To keep 
searching, see Step 5.

If Image Album 2.0 doesn't find any matching text, you will receive a prompt telling you so. 

Repeat the Search (Optional)

If Image Album 2.0 found a match for the text that you entered, you can keep searching to see if there are any other 
thumbnails with matching text:

Click on "Find" in the menu bar, then click on "Repeat Find".

Press F3.



Match Case Check Box
------------------------------------------------------------
-------

------------------------------------------------------------
-------
To turn the option on or off, click on "Match 
Case" or the check box, or press Alt+C.



Thumbnails

If you edit an image file, or if you edit the first frame of an animation file, the file's thumbnail will no longer 
accurately reflect the file's contents. To update the thumbnails in the current album, select "Update 
Thumbnails" from the Edit Menu:

Click on "Edit" in the menu bar, then click on "Update Thumbnails".

Press Alt+E, then press U.




